Louisiana Ethics Administration Disclosure &

Electronic Reporting System

User’s Guide

Louisiana Board of Ethics

sdr.

TECHNOLOGIES



Version 2.0, March 1999

Information in this document is subject to change without notice. Campaigns, candidates, names and/or data used in
the examples herein are fictitious unless otherwise noted.

© 1998 Louisiana Department of State Civil Service, Board of Ethics & SDR Technologies, Inc. All rights reserved.

Portions Copyright © Micro Focus Ltd., 1985-94
Portions Copyright © Microsoft Corp., 1993
Portions Copyright © Campaign Microsystems 1995-96

LEADERS was developed for the Louisiana Department of State Civil Service, Board of Ethics by:
SDR Technologies, Inc. Westlake Village, California
Program Design by SDR Technologies, Inc.
Project Management by SDR Technologies, Inc.

PDSERF Conversion by Campaign Microsystems

The LEADERS User’s Guide was written and designed by SDR Technologies, Inc.



CHAPTER 1: INSTALLATION, INTRODUCTION, GETTING STARTED . . ... ... ..ttt i 5
About Leaders . ... ... 5

About This User’s GUIde . . ... ..o e e e 5
Technical SUPPOrt . .. ..o 5
Installing the Program . .. ... .. .. . 5
The “ReadThis” File .. ... ... e e e 6
Windows 98, Windows 95 or Windows NT 4.0 Installation . . .................... 6

Starting the Program . . ... ... .. e 6
Navigating Throughout LEADERS . ... ... . e e e 6
Navigational Buttons . ... ... .. i e 6

TaD Ky . oo 7

Selecting Froma Drop Down List . . ........ .. i 7

Selecting From a Scrolling Menu . .............oitninini . 7

Status Bar .. ... 7

File MenU . . .o oo e e 8

Edit Menu .. ... 8

Help Menu . ..o e e 9

Getting Started . . .. ... 9

Before Using LEADERS ... ... o 9
Settingup a Filer ... ... 9

Names - Information . .. ........ . 10
Selecting a Previously Entered Name . . .. ........ ... ... ... ... .. ........ 11

CHAPTER 2: THE INSTRUCTIONS WINDOW . . ...ttt e et e e e e e 12
TaSKS ot 12

Filing Information .. ... ... .. ... . i e e 12

Print & Preview Report .. ... ... 12

Electronically File Report .. ....... ... i e 12



CHAPTER 3: FILING INFORMATION . . . ...ttt ettt e e 13
Forms and Form Entry Instructions .. ............ ..ttt e 13
Selecting the Appropriate Form & Schedule . ...... ... ... . . . . . . 13
Forms and Schedules - Information and Instructions . ............... i, 14

Form 100: Designation of Principal/Subsidiary Committee ............................ 14
Form 101: Candidate’s Affidavit in Lieuof Report . .. ........ ... .. .. .. ... ... ....... 14
Form 102: Candidate’s Report . . . ..... ..ot e 15
Schedule A-1, Form 102: Contributions Received (Other than In-Kind Contributions) 17
Schedule A-2, Form 102: In-kind Contributions . ............. . ... ... 17
Schedule A-3, Form 102: Other Receipts . ............ .. ... ... 17
Schedule B, Form 102: Loans Received . ............ ... . ... . ... 18
Schedule C, Form 102: Debts and Obligations (Other than Loans) ............... 18
Schedule D, Form, 102: Funds Loaned ............ ... ... .. . ... .. 19
Schedule E-1, Form 102: Expenditures ... ..........c.cooiiiiniiiinenen.... 19
Schedule E-2, Form 102: Other Disbursements .............................. 19
Schedule F, Form 102: Anonymous Contributions ............................ 19
Summary Page . ... .. . 20
Form 103: Candidate’s Special Report . ............ . i, 20
Schedule A, Form 103: Contributions (Including In-kind Contributions) ........... 21
Schedule B, Form 103: Loans Received . ........... .. ... .. . . i ... 21
Schedule C, Form 103: Expenditures To Those Who Make Endorsements ......... 21
Form 104: Candidate’s Election Day Expenditures Report .. ........................... 22
Schedule A, Form 104: Advertising . ..............utiiniininmnenananan... 22
Schedule B, Form 104: Election Day Workers ................ ... .. ... ....... 23
Schedule C, Form 104: Payments to Organizations ........................... 23
Form 200: Statement of Organization . .................uuirirmnnnnrennnennnanns 23
Form 205: Statement of Dissolution . ............ ... 25
CHAPTER 4: PRINT AND PREVIEW REPORT . ... ... .. . e e 26
LA PNt ™ 26
ZOOM . .ottt et et e e e e e 26
GO TO . 26
CHAPTER 5: ELECTRONICALLY FILE REPORT . . . ... ... ... . . e 27
Filing Upload . . ... ... .. e 27
Validation . . .. ..o 27
Error Messages and Explanations . ............. ... .. .. . o ... 28
Filing Method . ........ . . . i 29
Filing Configure (Communication Settings) .. ................c.... ... 29
Password/Filing ID .. ... ... . i i e 31

MAIL-IN AFFIDAVIT FORMS . . . ..o e e e 32



CHAPTER 1: INSTALLATION, INTRODUCTION, GETTING STARTED

About Leaders

LEADERS is a software program that allows you to enter all filing transactions (contributions, expenditures, etc.)
on-line. After you enter the information, LEADERS then creates all necessary forms and files for electronic filing with
the click of a mouse.

The Louisiana Board of Et hics is pleased to announce the release of LEADE RS (Louisiana Ethics Administration
Disclosure & Electronic Reporting System) version 2.0. This version contains many features designed to expedite the
filing process such as the ability to print validation results, Internet filing and direct dial-up filing.

An important new feature is the Digital Encrypted Password system being implemented by the Louisiana Board of
Ethics. Filers may choose to send their reports to the Louisiana Board of Ethics through TCP/IP (Internet access) or
via a direct dial connection (modem). The filer will n eed to complete an electronic filing affidavit and establish a
password that will be transmitted to the Louisiana Board of Ethics along with the encrypted file and the filer’s
Louisiana Board of Ethics Identification number. In order to take advantage of Internet or direct dial-up filing, you

must obtain a password from the Louisiana Board of Ethics. To obtain a password, call the Louisiana Board of Ethics
Electronic Filing Office at (225)219-5600 or at (800) 842-6630.

About This User’s Guide

This user’s guide contains detailed information about using LEADERS for Microsoft ® Windows ™.
TECHNICAL SUPPORT

If you have any questions or problems with the installation or use of LEADERS, please contact the Louisiana Ethics

Telephone: (225) 219-5600 or (800) 842-6630

Fax: (225) 381-7271
Email: ethics.louisiana@la.gov
Web site: httn://www.ethics.state.la.us

Administration Technical Support Staff.

INSTALLING THE PROGRAM

Diskettes:
> Please note that diskettes are numbered on the back with the LEADERS Version number and Disk Number.
> The Files in the program disk are compressed which means that you can’t just copy them to your hard disk

drive. You must use the Setup program. Follow the Windows 98, 95 or NT 4.0 Installation Instructions

below .
Download from the Internet:

> Go to the Board of Ethics website at httD://WWW.ethiCS.State. la.us/




The “ReadThis” File

Please review the information in the ReadThis file (if present) on the program disk. The ReadThis file may
contain changes that have been nmade since this user’s gude went to press, including revisions to the installation
procedures. Do not worryif the ReadThis file is not present in your version. This sinply means that there have
been no revisions to this user’s guide since publication.

WINDOWS 98, WINDOWS 95 OR WINDOWS NT 4.0 INSTALLATION

To install LEADERS, choose “Start” then “Run” fromthe Windows task bar. In the dialog box, type “A:setup”
and press return. It is usually best to accept the de fault prompts during the installation process. After
installation, a separate Start Menu Program Item appears called, “Louisiana Applications” (if you accepted the
default prompts). This will contain the new version of LEADERS.

STARTING THE PROGRAM

Now that you’ve successfully installed LEADERS, you wll see that an application group (foWindows) called
Louisiana Applications has been created. Open (by double clicking) the Louisiana Applications icon. (In

Windows 95, you may use the Start Menu to locate andtart the program in the Louisiana Applications folder).
The LEADERS program icon appears, and you may double click on it to open it. For infornmation on the next
steps to start using LEADERS, please see GETTING STARTED and CREATING THE REPORT later in this
chapter.

NOTE: Optimal viewing conditions are met by setting your monitor resolution to 800 X 600, if your

system is not capable of meeting these standards, or you experience difficulty viewing certain screens
and/or buttons within the LEADERS program, please contact technical support at (800) 367-5110.

NAVIGATING THROUGHOUT LEADERS

NAVIGATIONAL BUTTONS

You will use these navigational buttons to select from at the bottom of the forms screens:

Button Command

First Displays the first entry made.

Prior Displays the entry prior to the current entry being viewed.

Next Displays the next entry following the current entry being viewed.

Last Displays the last entry made.

Edit Activates the current screen to allow editing.

Add Clears data fields in the current view in order to enter a new transaction or list item. You may also clear
data fields to add a new activity by clicking the Next button until the fields are blank.

Delete Removes the current information being viewed.

Save Saves all changes.

Revert Discards changes and reverts to original values.

Browse Displays the browse list (contains all previously entered items for this “type” of entry). In a browse list

you may navigate with the arrow keys, highlight an item and press Enter to select it or press the Esc key to
close the list without selecting.

Exit

Exits the current window.




Tab Key

The tab key moves the cursor from field to field within a screen. The Tab key is very useful for moving
around a screen while entering data. Press Shift + Tab together to move the cursor in reverse to the
previous field.

Selecting From a Drop Down List

Some LEADERS windows feature a drop down list. These menus have pre-listed selections to choose
from. To select from a drop down menu, click your mouse on the arrow located within the right margin of
the field. You can quickly locate a selection by scrolling the selections or by entering the first few letters of
the selection. Highlight the selection and hit Enter.

Selecting From a Scrolling Menu

Within any window there may be a scrolling bar option that runs along the right margin. This is indicating
that you are only viewing a portion of the field. You must scroll to up or down to see all of the field’s
options/information.

There are three ways to operate the scrolling menu bar:

> Click your mouse on the upper or lowermost arrow on the bar. Each click will move the page one
line in the corresponding direction.

> Click the mouse inside the “gray” margin area between the upper and lower arrows. Depending on
which side of the “current marker” you click on, the page will move up or down one screen from
your current view.

> Place the pointer on the “current marker” that lies within the gray area between the upper arrows.

Click your left mouse button and hold it down while you “drag” the current marker with the
pointer in either direction. Your screen view will move in the direction that you drag the marker.

Status Bar

The Status Bar, found at the bottom of your screen, displays useful program information and directions.



File Menu

Option Command

New Filing Creates a new, blank file. See SETTING UP A FILER FOR DETAILED INFORMATION.

Open Opens an existing filing. Simply highlight the filer you want to open and click the Open button.
Names Displays every entity related to the filer through itemizations and “Names” entries. See NAMES -

INFORMATION for detailed information.

Auto Calculate Aggregates

Allows user to initiate automatic calculation of aggregates within the specified coverage period.

Recalculate Aggregates

Allows the user to update aggregates at any time within the specified coverage period.

Log-in Brings up the “Log-in Dialog Box”. You can Log-in by following these steps:
> From the File Menu, Choose the Log-in option.
> In the Name box, type ADMIN.
> In the Password box, leave it blank.
> Click OK.

Change Password Allows the user to change the password. You can change the password by following these steps:
> From the File Menu, choose the Change Password option.
> In the User Name box, type your User Name.
> In the Old Password box, type your current password.
> In the New Password box, type your new password.
> In the Re-enter Password box, type your New password again for confirmation.
> Click OK to change password, or click Cancel to abort with no changes.

Change User Name Allows the user to change his or her User Name. You can change the name by following these steps:
> From the File Menu, choose the Change User Name option.
> In the User Name box, type your User Name.
> In the New User Name box, type the new user name.
> Click OK to change user name, or click Cancel to abort with no changes.

Utilities Back-up: Creates a copy of the current filer data in a zip (archive) format, and allows you to save it
under the directory of your choice. Periodic “Back-ups” are recommended so that your data can be
salvaged should any problems arise.
Restore: Recreates the filer data from previously backed-up data. It is important that you record the
directory under which you originally backed up your filer data, so that it can be retrieved easily.
Reindex: Automatically compacts and resorts data.

Calculator Displays the Calculator Window.

Disable Sound Disables program sound. When selected, no sound indicators are heard.

Enable Sound

Enables program sound. When selected, you will hear all indicators with sound.

Exit Closes the LEADERS application and resets the system to defaults.
Edit Menu

Option Command

Undo Reverses the last action.

Redo Repeats the last action.

Cut Removes the current selection.

Copy Copies the current selection.

Paste Inserts the last cut or copied selection.

Clear Clears (deletes) selected text.

Select All Selects all text within the active area.




Help Menu

The Help Menu accesses the on-line help, as well as general information about the program.

GETTING STARTED

Before Using LEADERS

To make entering your data into LEADERS as easy as possible, you should have the following items:

> All relevant records and information such as bank statements, contributions and other receipt
records, loan information, and prior reports, if applicable.
> A cash on-hand balance amount, if you are a continuing campaign/committee.

If you are a continuing campaign/committee and wish to start the program showing all year-to-date
information, you must enter all year-to-date totals for all entities in a reporting period prior to the current
period.

If you wish to start this program at the beginning of a new reporting period, without cumulative totals, you
can start only with your cash on hand.

Setting up a Filer

When you open LEADERS for the first time to add your filer to the system, select the “New Filing” option
from the File Menu. The “New Filing” window appears.

In this “New Filing” Screen you will enter the following information:

> Unique 6 character name for this filing - This is your personal identifier for the filing. For
example, let’s say you are filing as the candidate “John Smith”. You may want to create your
identifier as “JSMITH” for easy reference. Remember, the identifier should be unique for your
own personal ease of use.

> Filing Type - Select Candidate from this drop down list.

> First Name - Enter the first name of the filer.

> Last Name - Enter the last name of the filer.

> Identification Number - This is the identification number assigned by the Louisiana Board of
Ethics.

Choose OK if your entry is satisfactory, or Cancel to abort this new filing.



Names - Information

The “Names” window has two tabs at the top labeled Data Entry (for entering a new entity) and List
which displays every entity related to the filer through itemizations and “Names” entries.
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You can efficiently construct a new entity by selecting the Names option from the Filer Menu and clicking
“Add” or “Edit”. Enter the following information:

Field Explanation
Name ID The system automatically numbers each entry.
Type Select the Entity Type by using the drop down menu. Highlight one of the following Entity Types:
> Individual > Political Committee (PAC) > Other Officer
> Legal Entity > Principal Campaign Committee > Preparer
> Lobbyist > Subsidiary Campaign > Ballot Measure
> Candidate Committee Sup/Opp
> Candidate Beneficiary » Chairperson > Anonymous
> Financial Institution > Treasurer > Real Estate Holding
> Deputy Treasurer
Mr./Ms. If entity is a person, enter a prefix of Mr. or Ms.

Last Name or

Enter one of the following depending on the type of filer:

Organization > Last Name, if the entity is an individual; OR

> Name of Organization, Business, Committee, etc.
Address Enter the address of the filing entity.
City Enter the city, for the address, of the filing entity.
State Enter the two-letter state code, for the address, of the filing entity.
Zip Enter the zip code, for the address, of the filing entity.
Phone Enter the entity’s main telephone number (optional).

Note: After you have entered an entity into the system, they are available to browse for selection.



SELECTING A PREVIOUSLY ENTERED NAME FROM YOUR DATABASE
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LEADERS allows for data entry shortcuts when entering names information within schedules and/or cover
pages. From the various Filing Information Screens, you may select a name from your database, using your
TAB key, and all of the information for the selected individual/organization will be transferred to the current

data entry fields.

For example, rather than re-entering all relevant information for a contributor within a schedule or cover

page, simply:
> select edit

> if it isn’t there already,
make sure your cursor is
in the Name field.

> Press the Tab key from
within this field and you
will be prompted by the
Names listing of each
entry in your database
thus far. You may
either scroll through the
list using your arrow
keys, or with your
mouse pointer to locate
your selection.

> Press Enter on your
keyboard, and
information for your
selection will
automatically transfer

to the schedule or cover

page for which you are
currently providing

information. This action |

may be repeated as
often as necessary.
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CHAPTER 2: THE INSTRUCTIONS WINDOW

The Instructions Window contains “Task” selections along the left margin, and the “Forms” list in the right

margin.

Instructions

Choosa the fask € Form 100 - Designation of PrincipaliSubsidiary Committee
TASKS you would like to O Form 101 - Candidate’s Affidavit in Lieu of Report

perform and click C Form 102 - Candidate's Report

Next.. € Form 103 - Candidate's Special Report
You may select one of the following Tasks b y ; Forrm 104 - Candidate’s Election Day Expenditures
clicking your mouse on the corresponding button, o e e

Click here to enter orm 2 itin Ligu of Report
then click <<Next>> to enter the edit windows. filing information. @ Form 2

arm 205 ytion
Click here to print &

@ Form 2 - I Report
E& | @ Form 2 - Committes gction Day Expendituras
&F ant of {

preview report. @ Forrm 400- ure Form
@& Form 401 3
| @ Form 402 A  Staternent
@ Form 4 1 ure Statement Pursuant

Click here to @& Form ¢ Registration
electronically file & Fo Supplemental Registration
report. R
Help | Click next to continue Next >» |

Filing Information

Select this button to enter your filing information.

All of the information regarding your filer and filing
data is available when the filing information task
button is selected. See FILING INFORMATION for more
detailed information.

Print & Preview Report

Select this button to preview the active file report.
After you have previewed the report, you can select
to send the report to your printer.

LAPrint™ is a printing and previewing utility that

will first show the report graphically (as it will appear
when printed), then give the option of printing the
report. See PRINT & PREVIEW REPORT for more detailed
information.

Electronically File Report

Select this button to electronically file your completed
report to the Louisiana Board of Ethics via the Internet,
modem or floppy diskette.

LALoad™ provides filers with the convenience of being
able to submit disclosure filings electronically. See
ELECTRONICALLY FILE REPORT for more detailed information.
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CHAPTER 3: FILING INFORMATION

FORMS AND FORM ENTRY INSTRUCTIONS

You will see that each form selection has a circle in frontof the formtitle. Those circles that are “grayedout”
cannot be selected because they do not pertain to youtfiling type”. Therefore, click yourmouse on the “white
circle” of the selection you want to go to which willm  ark it with a “dot”. After youh ave marked the
appropriate form, click on the <<Next>> button in the bottom right corner of the Instructions Window. You
will be taken to the window that contains data fields where you can now enter the information for the type of
itemization you have selected.

SELECTING THE APPROPRIATE FORM & SCHEDULE

Use the following chart to cross reference the type of transaction with the appropriate form and schedule.

Transaction Type Form/Schedule
General Contribution 102/A-1
General In-kind Contribution 102/A-2

Other Receipt 102/A-3
General Expenditure 102/E-1

Other Disbursement 102/E-2
Contribution from Candidate 102/A-1
Contribution from Political Committee 102/A-1

In-kind Contribution from Political Committee 102/A-2
Proceeds from sale of fundraiser tickets 102/A-1
Proceeds from sale of Campaign Paraphernalia 102/A-1 or Summary Page
Expenditure from petty cash fund 102/E-1
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FORMS AND SCHEDULES - INFORMATION AND INSTRUCTIONS

Form 100: Designation of Principal/Subsidiary Committee
General Information - Description of Principal/Subsidiary Campaign Committees

A candidate may designate one political committee as his or her principal campaign committee. A candidate
may also designate one or more political committees as his or her subsidiary committees. Further, a principal
campaign committee may designate subsidiary committees. Any designated committee must file a Statement
of Organization and submita $100filing fee. The use ofprincipal or subsidiary committees is entirely optional.
If committees are used, this report m ust be filed no la ter than 10 days a fter the designation is made. Ifa
committee is organized to support a single candidate andthat candidate refuses to designate thatcommittee as
his/her principal or subsidiary committee he must file a statement, in writing, disavowing the conmittee. Once
such a disavowal is filed, no funds may be exchanged between the candidate and committee.

Instructions - Form 100 (Always click “Edit” to activate a screen)

1. Enter the full nam e and address of the candidate or principal ¢ ampaign committee making the
designation.
2. Enter the title of the office being sought by the ca ndidate as well as the parish, city, town and/or

election district.

3. Principal campaign committee designated (form must be submitted by candidate)*You must right click
on the grid to enter this information*
> Enter the full name and address of the designated principal campaign committee.
> Enter the name of the chairperson of the designated principal campaign committee.

4. Subsidiary committees designated (if any, the form may be submitted by candidate or principal
campaign committee). *You must right click on the grid to enter this information*
> Enter the full name and address of each subsidiary committee you are designating.
> Enter the name of the Chairperson relative toeach of the designated subsidiary conmittees.

5. Certification of Designation by the candidate or principal campaign committee. Form 100 must be
signed by the candidate designating the principal campaign committee or by the Chairperson of the

principal campaign committee only if a conmittee is designating subsidiary committee(s). If the form
is filed electronically, a typed signature is adequate.

Form 101: Candidate’s Affidavit in Lieu of Report

General Information - Candidate’s Affidavit in Lieu of Report

This form should be used only if all of the following criteria are met:

1. Candidate is running for a “major” or “district” office;
2. Contributions from one source in excess of $200 have not been received for this election;
3. Expenditures in excess of $5,000 have not been made for this election; and

4. An itemized (long) report has not been filed in connection with this election.
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Instructions - Form 101 (You must click “Edit” to activate a screen)
1. Enter the full name and address of the candidate.

2. Enter the office sought by the candidate in this election. (Include title of office as well as parish, city,
town and/or election district).

3. Enter the date of the election. If the election date is not yet known, enter the anticipated year of the
election. Additionally, enter the period the report is covering.

4. Select the type of report the candidate is filing from the drop down list.

5. If this is the Final Report, check the appropriate box to indicate whether the candidate withdrew from
the election or was unopposed.

6. Right click on the grid and:
a. Enter the full name of the person preparing the report.
b. Enter a daytime telephone number where this person may be reached during business hours.

7. Principal Campaign Committees Only, right click on the grid and:

a. Enter the name and address of the principal campaign committee.
b. Enter the name and address of the committee’s chairperson.
c. Enter the name and address of all subsidiary committees, if any.

8. Complete the certification by having the signature of the candidate (or committee chairperson only
if the report is filed by the principal canpaign committee) notarized on a paper copy of the reportand
forwarded to the Board of Ethics.

Form 102: Candidate’s Report

General Information - Candidate’s Report

All transactions must be reported, regardless of amount. Exception: In-kind transactions valued at $25 or less
are not required to be reported. However, successive trasactions must be added together todetermine whether
$25 has been exceeded.

A campaign bank account must be maintained. All contributions must be deposited in the campaign account.
All expenditures must be made by checks drawn on the canpaign account. The check(s) nust be made payable
to a specific person and indicate the object or services for which it was drawn. Exception: A petty cash fund
may be maintained and used for expenditures of $100 or less that are not for personal services.

Cash contributions in excess of $100 fronone source during a calendar year are prohibited. Acash contributor
must be given a receipt containing his name, address, social security number and signature, and the date and
exact amount of the contribution. The campaign must keep a copy of the receipt.

A record must be kept for every transaction, including the sale of tickets to fundraising events. This sale of a
ticket to a fundraising event is reported as any other comibution. Exception: In the case of single transaction
involving the sale of campaign paraphernalia for $25 or less, no record need be kept except the total amount
received and deposited and the factthat such amount was received from such sale. The total anount is reported
on Line 3 of the Summary Page.

The following contribution lim its apply: $5,000 for m ajor office candidates, $2,500 for district office
candidates, and $1,000 for any otheroffice candidates. You may not accept more than your contribution limit
from one source per election. You may not accept contributions from persons substantially interested in the
gaming industry. The primary and general are considered two separate elections. When calculating whether
or not the limits have been reached, outstanding loans,endorsements or guarantees on loans, and contributions
must be added together.
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The term “this election” as used throughout this form refers to the period from the date of first becoming a
candidate (the day the first contribution was accepted, the first expenditure made, or the date of qualification
to run for office, whichever came first) through the closing date of the current report.

Separate reporting forms are to be used for “Special Reports” and “Election Day Expenditures”.

A candidate may report through a principal campaign committee. The use of a committee is strictly optional.
If a committee is used the candidate m ust file a “Designation of Principal Cam paign Committee.” The
committee must file a statement of organization in January of each year that in which it will have over $500
in financial activity. A $100 filing fee must be submitted annually with each Statement of Organization.

Contributions or loans in th e name of another are prohibited. If funds are m ade available to a candidate’s
campaign by a person who was loaned those funds by a third party, the name of the third party must also be
disclosed.

Expenditures made by a public relations firman advertising agency or agent for the canpaign must be reported
to the campaign; the ultimate recipients of any such expenditures are required to be reported on Schedule E-1
of this report.

Expenditures, including any reimbursement of costs, to persons to transport voters to the polls are prohibited.
Exception: payments to transport voters are allowed if made to a bona fide bus, taxi or transportation service
duly licensed by a governmental entity.

Instructions - Form 102 (Always click edit to activate a screen)

Cover Page

1. Enter the qualifying name and address of the candidate. The “qualifying name” is the name used or
to be used by the candidate on the Notice of Candidacy.

2. Enter the specific officesought by the candidate. Inchide the parish, city, town and/or election district.

3. Enter the date of the election. If the election date is not yet known, enter the anticipated year of the
election.

4. Select the type of report the candidate is filing from the drop down list and enter the dates the report
covers.

5. If this is the candidate’s final report, check the appropriate status.

Cover Page 11

6. Right click on the grid and enter the nam e and address of the financial institution(s) which is (are )

being used as a depository for campaign funds. NOTE: The candidate is required by law to use one
or more banks, savings and loan associations, or money market mutual funds as the depository of all
campaign funds.

7. Enter the full name and address of the candidate’s campaign treasurer if applicable.

8. If this report is being filed by a candidate’s principal campaign committee:

a. Enter the complete name and address of principal campaign committee.
b. Enter the full name of the committee’s chairperson.
c. Enter the complete name and address of all subsidiary committees, if any.

a. Enter the name of the person preparing this report.
b. Enter a daytime telephone number where this person may be contacted during regular business
hours.

10. Complete certification with the date the report isbeing filed and the signatures of the candidate orthe
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committee chairperson and thetreasurer, if any. NOTE: The report should be signed byhe committee
chairperson only if report is being filed on behalf of principal campaign committee.

SCHEDULE A-1, FORM 102: CONTRIBUTIONS RECEIVED (OTHER THAN IN-KIND
CONTRIBUTIONS)

The information on this schedule must be provided for all contributors to your campaign during this reporting
period, except for in-kind contributions. Infornation on in-kind contributions isreported in SCHEDULE A-2:
IN-KIND CONTRIBUTIONS. Any personal funds a candi date contributes to his/her cam paign must be
reported on this schedule. Pers onal funds that a candidate loans to his cam paign should be reported on
Schedule B. For anonymous contributions, see SCHEDULE F.

1. Enter the name and address of each contributor. If the contributor is a political committee or a party
committee, you must indicate so by placing a check by the appropriate box.

2. Enter the date andamount of the contributor’s contrbution. Also, select the type of contribution from
the drop down list.

3. Enter the total contributions m ade during this election by the con tributor unless you have already
selected “Auto Calculate Aggregates.”

SCHEDULE A-2, FORM 102: IN-KIND CONTRIBUTIONS

The information on this schedule must be provided for all in-kind contributions to your cam paign having a
monetary value in excess of $25. In-kind contributioninclude the donation of tangibleproperty or the services
of employees paid by a person other than the candidate or his/her business. Any in-kind contributions a
candidate makes to his/her own campaign must be reported here.

1. Enter the name and address of each in-kind contributor.
2. Enter the date and amount of the contributor’s in-kind contribution.
3. If the in-kind contributor is a political com mittee or a party committee, you must indicate so by

placing a check in the appropriate box.
4. Enter a brief description of the in-kind contribution.

5. Enter the total in-kind contributionsmade during this election by the contributor listed unless you have
already selected “Auto Calculate Aggregates.”

SCHEDULE A-3, FORM 102: OTHER RECEIPTS

Use this schedule to report thosereceipts that are not “contributions”; that is, monies paid to the canpaign that
are not given for the purpose of supporting, opposing or otherwise influencing the nomination or election of
a candidate to public office. Examples include interest or investment income. Receipts should be reported on
this schedule only if they have nobeen reported elsewhere in this report. The explanation of theeceipt should
state the reason the payment was made to the campaign.

Enter the name and address of each source, the date andmount of the receipt, andan explanation of the receipt.
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SCHEDULE B, FORM 102: LOANS RECEIVED

The required information must be provided for each loan or line of credit received this reporting period, even
if it has been repaid. Also, conplete this schedule for loans received in prior periods that are stilloutstanding.
Separate loans must be reported separately, even if fron the same source. Any personal funds a candidatéoans
to his/her campaign must be reported on this schedule.

1. Enter the name and address of the lender.
2. a. Enter the date of the loan. For lines of credit, enter the date when the line of credit was first
committed.

b. Enter the interest rate.
c. Enter the amount borrowed. For lines of credit, enter only the amount actually drawn.
d. Enter the balance due.

OPTIONAL - Total amount of credit available. For lines of credit, you may enter the total amount
of credit available if you wish.

3. Right click on the grid and enter the full nane and address of each person or entity that has endorsed,
guaranteed or otherwise secured a loan or line of credit. Also, state the amount of liability for each
endorser or guarantor.

4. Repayments this Period. Right click on the grid and:
a. Enter the date of repayment.
b. Enter the amount of principal included in this repayment.*
c. Enter the amount of interest included in this repayment.*

* List payments of principal and interest separately. If separate amount are not known, list all
payments under principal.

SCHEDULE C, FORM 102: DEBTS AND OBLIGATIONS (OTHER THAN LOANS)

Use this schedule to report either debts owed by the campaign or debts owed to the campaign, clicking on the

appropriate circle at the top of the schedule. If the campaign has experienced both types of debts, then report
them separately. Never conbine debts “owed by” and dbts “owed to” the campaign. Debts should be reported
on this schedule until repaid. When repayments are made by the campaign, a corresponding entry should be

made on SCHEDULE E-1: GENERAL EXPENDITURES. When repayments are received by the campaign,

a corresponding entry should be made on SCHEDULE A-3: OTHER RECEIPTS.

Click the appropriate circle as to whether this is “owed by” or “owed to” the candidate.

1. Enter the name and address of the creditor or debtor.

2. Enter the outstanding balance beginning this period.

3. Any amount(s) incurred this reporting period.

4. Enter any payment(s) made this reporting period.

5. If you are reporting a debt, enter the reason the debt was incurred in the space provided.

SCHEDULE D, FORM, 102: FUNDS LOANED

The required information must be provided for each loan or line of credit made this reporting period, even if
it has been repaid. Also, complete this schedule for loans m ade in prior periods that are still outstanding.
Separate loans must be reported separately, even if to the same borrower.
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1. Enter the name and address of the borrower.

2. a. Enter the date of the loan. For lines of credit, enter the date when the line of credit was first
committed.
b. Enter the interest rate.
c. Enter the balance due.

3. Right click on the gridand enter the full name and address of each person or entity that has endorsed,
guaranteed or otherwise secured the loan or line ofcredit. Also, state the amount of liability for each
endorser or guarantor.

4. Repayments this Period. Right click on the grid and:
a. Enter the date of repayment
b. Enter the amount of principal included in this repayment*
c. Enter the amount of interest included in this repayment*

* List payments of principal and interest separately . If separate amounts are not known, list all
payments under principal.

SCHEDULE E-1, FORM 102: EXPENDITURES

Use this schedule to report inform ation on all cam paign expenditures for this reporting period. An
“expenditure” is any payment made for the purpose of supporting your election to public office and includes
monies spent for the campaign’s general operating expenses. Any payments made that are not “expenditures”
should be reported on SCHEDULE E-2: OTHER DISBURSEMENTS.

Enter the name and address of the recipient, the date, amount and purpose of the expenditure.

SCHEDULE E-2, FORM 102: OTHER DISBURSEMENTS

Use this schedule to report those disbursem ents that are not “expenditures”; that is, m onies paid by the
campaign that are not paid for thepurpose of supporting, opposing or otherwise influencing the nomination or
election of a candidate to publicoffice. Examples include the payment of taxes or the refund of contributions.
Disbursements should be reported on this schedule only ifhey have not been reported elsewhere in this report.
The explanation of the disbursement should state the reason the payment was made by the campaign.

Enter the name and address of the recipient, the date, amount and an explanation of the disbursement.

SCHEDULE F, FORM 102: ANONYMOUS CONTRIBUTIONS

Anonymous contributions must be transmitted to the State- they cannot be kept or used.On this schedule, state

the date and amount of each anonymous contribution received during this reporting period, as well as the date
that each contribution was transmitted to the State. Receipts from the sale of campaign paraphernalia (items

such as political campaign pins, buttons, hats, t-shirts, bumper stickers, literature, etc.) in transactions of $25

or less are not considered anonymous contributions.

Anonymous contributions should be m ailed by campaign check to the Treasure r of the State of Louisiana,
accompanied with an explanation that the check represents an anonymous campaign contribution forwarded
pursuant to LSA-R.S. 18:1505.2B.

1. Enter the date of the anonymous contribution received.

2. Enter the amount of the anonymous contribution.

3. Enter the date the anonymous contribution was transmitted to the State.
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SUMMARY PAGE

For Summary Page entries, eachline is auto-calculated based on entries made into the systemunder the various
schedules with the exception of lines 3, 19 and 20. Infemation for each of these threelines should be entered
manually.

Line 3: Campaign Paraphernalia sales of $25 or less

Line 19: Of funds on hand at beginning of reporting period (Line 14 above), amount held in investments

Line 20: Of funds on hand at close of reporting period (Line 18 above), amount held in investments

Form 103: Candidate’s Special Form

General Information - Candidate’s Special Report

This form is filed during the 20 day period immediately preceding an election to report (1) all receipts froma
single source in excess of $500 by major office candidates, or in excess of $250 to any person who endorses

candidates and who is required to file campaign disclosure reports.

All candidates who have had any such transactions within the 20 days immediately preceding an election are
required to report any such transaction on this form within 48 hours of the time the transaction occurred.

Instructions - Form 103 (Always click on “Edit” to activate a screen)
Cover Page

1. Enter the qualifying name and address of the candidate. The “qualifying name” is the name used or
to be used by the candidate on his/her Notice of Candidacy.

2. Enter the specific office sought by the candidate. Include the parish, city, town, and/or  election
district.
3. Click the appropriate circle to indicate whether the report is fil ed before the prim ary or general

election. Enter the date of the electioNote: Information will only appear on this report that falls
on dates specified within this range). Enter the date the report is being filed.

Cover Page 11

4. Right click on the grid
a. Enter the name and address of the person preparing this report and a daytime telephone number
where this person may be contacted during business hours.
b. Enter the name and address of the principal campaign committee

5. Enter the date the report is being filed. Conplete certification with the signatures ofthe candidate or
committee chairperson and the treasurer, if any. NOTE: The report should be signed by the comittee
chairperson only if report is being filed on behalf of a principal campaign committee. If the form is
filed electronically, a typed signature is adequate.

SCHEDULE A, FORM 103: CONTRIBUTIONS (INCLUDING IN-KIND CONTRIBUTIONS)

MAJOR OFFICE CANDIDATES: The following information must be reported for all contributions and in-
kind contributions exceeding $500 received during thdast 20 days before the primary election, as well as those
received in the last 20 days before the general election if the candidate participates in the general

election.
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DISTRICT OFFICE CANDIDATES AND ANY OTHER OFFICE CANDIDATES:  The following
information must be reported for all contributions and in-kind contributions exceeding $250 received during
the last 20 days before the primary election, as well as those received in the last 20 days before the general
election.

1. Enter the name and address of each contributor.

2. Indicate the receipt type from the drop down list.

3. Enter the date of the contributor’s contribution.

4. Enter the amount of the contributor’s contribution.

5. If an in-kind contribution, enter the total valuation and a brief description.

SCHEDULE B, FORM 103: LOANS RECEIVED

MAJOR OFFICE CANDIDATES: The following information must be reported for all loans exceeding $250
received during the last 20 days before theprimary election, as well as those received in the last 20 days before
the general election if the candidate participates in the general election.

DISTRICT OFFICE CANDIDATES AND ANY OTHER OFFICE CANDIDATES:  The following
information must be reported for all loans exceeding $250 received during the last 20 days before the primary
election, as well as those received in the last 20 days before the general election if the candidate participates
in the general election.

1. Enter the name and address of the lender.
2. a. Enter the date of the loan.

b. Enter the interest rate.

c. Enter the amount borrowed.

d. Enter the balance due.

OPTIONAL: Enter the credit limit amount if a line of credit.
3. Right click on the grid and enter the full nane and address of each personor entity that has endorsed,

guaranteed or otherwise secured the loan or line ofcredit. Also, state the anount of liability for each
endorser or guarantor whose liability is less than the entire amount.

SCHEDULE C, FORM 103: EXPENDITURES TO THOSE WHO MAKE ENDORSEMENTS

Use this schedule to report canpaign expenditures in excess of $200 during the last 20 days before the primary
or general election, if the candidate participates in tk general election, made to any person or organization that
makes endorsements of candidates and who is required to file campaign finance disclosure reports.

1. Enter the name and address of the recipient.

2. Enter the date of the expenditure.

3. Enter the amount of the expenditure and a description if in-kind expenditure.
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Form 104: Candidate’s Election Day Expenditures Report

General Information - Candidate’s Election Day Expenditures

This report is required to be filed byll candidates who are required tofile campaign finance disclosure reports,
even if no election day expenditures were made. The report is due no later than 10 days after the prim ary

election, and again, 10 days after the general election if the candidate participates in the general election.

This form is used to report payments by the candidate or his/her political committee:

1. For advertising that is broadcast or published on election day;
2. For the services of election day workers; and
3. To organizations for election day activities in support of the candidate.

NOTE: This report is required in addition to all other required reports. Therefore, the expenditures reported
on this report must be reported in subsequent “Candidate’s Reports™ for this election.

Instructions - Form 104 (Always click on “Edit” to activate a screen)
Cover Page

1. Enter the qualifying name and address of the candidate. The “qualifying name” is the name used or
to be used by the candidate on his/her Notice of Candidacy.

2. Enter the specific office sought by the candidate. Inalde the parish, city, town and/or election district.
3. Enter the name and address of the candidate’s principal campaign committee, if any.

Cover Page 11

4. Click on the appropriate circle tandicate whether this report relates to the prinary or general election.

Enter the date of the election (Note: Information will only appear on this report that falls on dates
specified within this range).

5. a. Enter the full name of the person preparing the report.
b. Enter a daytime telephone number where this person may be contacted during business hours.

6. Complete certification with the date the report is being filed and the signatures of the candidate or
committee chairperson and the treasurer, if any. NOTE: The report should be signed by the

committee chairperson only if report is being filed on behalf of a principal campaign committee. If
the report is filed electronically, a typed signature is adequate.

SCHEDULE A, FORM 104: ADVERTISING

The required information must be provided foreach person to whoman expenditure was nade for the purchase
of television, radio or newspaper advertising broadcast or published on election day.

1. Enter the name and address of the recipient.

2. Click on the appropriate circle to indicate whethe r the expenditure is for the prim ary or general
election and select the year.

3. Indicate the type of advertising by selecting from the drop down list.

4. Enter the date & total amount paid to the recipient.
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SCHEDULE B, FORM 104: ELECTION DAY WORKERS

The following information must be provided for each individual to whonan expenditure was nade for services
performed on election day. Also, the infornation must be provided for each individual perfornmng services on
election day to whom a monetary expenditure was made by an organization to which a payment was made by
the candidate completing this report.

1. Enter the name and address of recipient.

2. Click on the appropriate circle to indicate whether the expenditure is for the prim  ary or general
election and select the year.

3. The social security number of the recipient is no bnger required. Please leave this field blank. Wen
you file electronically you may receive a validation error similar to this:

EXPN,B 4 014 Conditionally Required field is Empty
'--> Rept_ SSN
'--> Line-item Name: Deaux"Johnny™"
You may safely ignore this error.

4. Enter the date & total amount paid to the recipient.

5. Enter the organization making the payment, if applicable.

SCHEDULE C, FORM 104: PAYMENTS TO ORGANIZATIONS

The required information must be provided for each organization to which the candidate has made payments
for any service(s) performed on election day.

1. Enter the name and address of the organization receiving the payment.

2. Click on the appropriate circle to indicate whethe r the expenditure is for the prim ary or general
election and select the year.

3. Enter the date & amount paid to the organization.

4. Enter the purpose of the payment.

Form 200: Statement of Organization

General Information - Statement of Organization

A $100 filing fee must accompany the Statement of Organization. The fee should be paid with a committee
check payable to “Campaign Finance.” The form may be electronically filed, but the check m ust be hand

delivered or mailed no later than the nextworking day following the due date of the Statement of Organization.

This form must be filed every year between January 1 and January 31, subject to the following exceptions:

> If a committee organizes after January 31, then this form must be filed within 3 days of the date o f
organization.

> If the committee organizes within 10 days prior to an election, then this form must be filed within 3
days of the date of organization

> If the committee does not anticipate that it will have over $500 in total financial activity for a

particular calendar year, it is not required to file this form for that year. If it determines later in that
year that it will exceed $500 in total financial activity, then this form must be filed within 10 days.
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A Certificate of Registration will be issued to each properly organized committee.

A committee that has over $500 of financial activity in a calendar year and does not file a Statem ent of
Organization is subject to fines.

Mail or hand deliver the required fee to:

CAMPAIGN FINANCE
P. O. Box 4368
Baton Rouge, LA 70821

Instructions - Form 200 (Always click “Edit” to activate a screen.)

1.

Enter the name and address of the com mittee. Committee names must comply with the following
rules:

> The name cannot be the sam e as or decep tively similar to the nam e of another political
committee.

> If the committee supports only one candidate, the committee name must contain the name
of that candidate.

> If the committee supports only one candidate, the committee name cannot contain the name

of an individual unless the com mittee name clearly reflects that the committee is not
supporting or opposing only that individual.

> If the committee uses an acronym in addition to its com plete name, place the acronym in
parentheses after the complete name.
> If the committee name contains a number, spell out the number in the name and place the

numerical symbol(s) in parentheses.

Enter the date the Statement of Organization is completed. Enter a check if this is the first year a
committee has registered.

Enter the estimated number of members the committee anticipates it will have this year. Check if the
committee has over 250 members who contributed over $50 to the committee during the preceding
calendar year. Meeting this membership requirement allows the committee to contribute double the
contribution limit to candidates.

Check “Yes” if this filing is an am endment to a previously filed Statement of Organization. Any
change in the information reported on this form that occurs before the conmittee’s next Statement of
Organization is otherwise due must be reported by filing an anended Statement of Organization within
10 days following the change. No filing fee is required for the filing of such an amendment.

Right click on the grid and enter the necessary information with regard to allcommittee officers and/or
directors:

a. Enter the full name of each officer/director.

b. Enter the complete address of the officer/director.

c. Enter the position of the officer/director (e.g. Chairperson, Treasurer).

Enter the necessary information with regardto any affiliated organizations. An affiliated organization
is any organization, other than a political com mittee, which directly or indirectly established,
administers or financially supports this committee.

a. Enter the full name of each affiliated organization.

b. Enter the complete address of each affiliated organization noted in 6a.

c. Enter the relationship of the affiliated organization to the political committee.

Enter the necessary information for all depositories for committee funds. NOTE: Committee funds
must be deposited in one or nore banks, savings and loans institutions or noney market mutual funds.
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a. Enter the full name of each depository.
b. Enter the complete address of each depository.

Indicate whether this committee supports a single candidate by checking “yes” or “no”. IfNo, go to

Item 9. If Yes, there must be a Statement of Designation (Form 100) completed by the candidate or

his principal campaign committee for this committee already on file or accompanying this form. If

this committee will be supporting a candidate:

a. Check whether the committee will be designated as the principal campaign committee or a
subsidiary committee; check whether the committee will support or oppose the candidate;

b. Enter the candidate’s qualifying name;

c. Enter the office sought by the candidate.

Enter the full name of the person preparing the Statement of Organization.
Enter a daytime telephone number where this person may be contacted during business hours.

o e

Complete date of certification and all required signdures and telephone numbers. If this formis being
filed electronically, a typed signature is adequate.

Form 205: Statement of Dissolution

General Information - Statement of Dissolution

Each political committee, including any subsidiary committee, which after having filed anannual statement of
organization wishes to dissolve or disband and:

1.

Determines that it has not received any contributions, transfers of funds, or loans and has not made
expenditures, transfers of funds, or loans in the aggregate during the calendar year in excess of five
hundred dollars ($500) and does not anticipate doing so, OR

Determines that it will no longer receive any contrbutions, loans, or transfers of funds and no longer
make any expenditures, loans, transfers of funds and shall file a statement of dissolution with the
supervisory committee prior to dissolving.

All committee debts and obligations must be paid or otherwise extinguished and any funds on hand must be
expended or otherwise distributed before a political committee can dissolve.

Instructions - Form 205 (Always check “Edit” to activate a screen.)

1.

Enter the full name and address of the political committee as it was designated on the Statement of
Organization. Enter the date of the statement.

Enter the complete name and address of the Committee’s chairperson.

Check whether this committee was the principal campaign committee of a candidate. If yes, then
specify the full name and address of the candidate.

Check whether this com mittee was a subsidiary com mittee designated by either a candidate or a
principal campaign committee. If yes, then specify the full name and address of the candidate or
committee.

Complete date of certification and all required signdures and telephone numbers. If this formis filed
electronically, a typed signature is adequate.
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CHAPTER 4: PRINT AND PREVIEW REPORT

In order to run LAPrint™, follow these steps:
Note: A form (report) MUST be selected in order to utilize the Print options.

> From the Instructions Window,
select the Print & Preview button & Form 100 - Designation of PrincipalfSubsidiary Committee
O Form 101 - Candidate's Affidavitin Lieu of Report
' Form 102 - Candidate's Report
> The file to be prin ted will C Form 102 - Candidate's Special Regport

| O Form 104 - Candidate's Election Day Expenditures
€ Form 200 - Staternent of Drganization

@ Form 201 - Committes's Affdavitin Lisu of Repart
& Form 202 - Commitiee's Report

@ Form 203 - Committee's Special Report

& Form 204 - Gommities's Election Day Expendiiures
' Form 205 - Staternent of Dissalution

- @ Form 400 - Personal Financial Disclogure Form

@ Form 401 - Gaming Control Board FDS

appear as a preview on the
screen, in the appropriate
“forms” format.

> From here you may print out the
actual forms on paper. Select
File, then Print.

> In the Print Screen, you can
choose the printer, print range
and the num ber of copies to

@ Form 500 - Lobbvist Registration
@ Form 501 - Lobbvist Supplemental Registration
- & Form 507 - Loblwist Expenditure Report

@ Form 402 - LRA-RS. 3912331 Disclosure Statement
@ Form 403 - LSA-R.E. 42:1119R Disclosure Statement Pursuant

print. Once you have selected e
your options, select OK.

LAPrint™ Options:

While previewing the file you can zoom in/out, or go to a specific page in the file.

To Zoom

> From the Menu Bar, select View.

> Select the Zoom option.

> Enter a number in the percentage window and select Enter.

To Go To a Specific Page

Use the vertical scroll bar on the right side of your screen to scroll up and down or to view a specific page.



CHAPTER 5: ELECTRONICALLY FILE REPORT

Filing Upload

In order to run LALoad™, follow these steps:
Note: A form (report form) MUST be selected
in order to use the Load options.

h

At

Instructions
Chonse the fask
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C Form 100-
C Form 101 -

Designation of PrincipaliSubsidiary Cammittes
Candidate's Affidavitin Lieu of Repart

you would like to

> From the Instructions Window, select

€ Farm 102 - Candidate's Report
. . perform and click =
the Electronically File Report Button.

Iext. € Form 103 - Candidate's Special Report

Click hete to enter
filing informatin.

&

Click here to print &
preview report.

€ Form 200 - Statement of Organizatian
@ Form 201 -
€ Form 202 - Commitiee's Repart

€ Form 203 - Committee's Special Report

> Click the <<Ne xt>> Button in the
lower right hand corner of the
Instructions Window, and the “filer”
will automatically undergo the

. . ' Form 204 - Statement of Dissalution
LALoad™ verification and fi  le N

process. & Form 401 - Gaming Control Board FDS
1::] & Form 402 - LS&R. S, 38:1233.1 Disclosure Statement
> You will be prom pted as to whether e  Form 403 - LEA-RS. 42:1119§ Digclosure Statement Pursuant
fili d initial Iml il I? - € Form 500 - Lobbyist Registration
or not your 1 lng passe mitia reen‘ajcm;omca Pl € Farm 501 - Labbyist Supplemantal Registration

diagnostics. If it failed, select 8 Form 507 - Lobbyist Expenditure Repart

€ Farm 104 - Candidate's Election Day Expenditures

Committes's Afdavit in Lisy of Repart

€ Form 204 - Commitiee's Election Day Expendiures

€ Form 400 - Personal Financial Disclosure Form

<<Details>> to determ ine where in
the selected report that the errors

Help |

Click next to continue

Mey == |

exist, so that you may return to the
filing information screen to make corrections.

The content of the current report is checked for conpleteness and correctness, and the results of this check are
displayed in the Validation Window.
> The first line of the validation output is the “Validation Summary,” followed by a “checksum”.

> If the current report fails validation, the m essages in the Validat ion window should be used to
diagnose and correct the errors.

The following are examples of error messages you may receive:

RecType Err Col
Example Form Type Luvl # Description
#1 CVD,F102 12 007 is Required, but field is Empty
> Rpt_Date
#2 RCPT, A-1 12 005 is Required, but field is Empty
> Address 1
t> Line-item Name: P.C.M.
#3 RCPT,A-2 4 009 Zip Code is Invalid or Missing/Zip = 45475

C> Zip4
> Line - item Name: Other State Party

You must correct errors with ERR LVL + 8 or greater. Reports with ERR LVL greater than or equal to 8 are
not, normally, accepted by the server. Therefore, while Examples #1 and #2 MUST be corrected PRIOR to
filing, the corrections needed for Example #3 should be performed, but are not necessary for the filing to be
accepted by the server.

Although reports with ERR LVL less than 8 may be accepted by theserver, you are advised to correct all errors
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before uploading a report.

Note: You may use the validator atany time during the data entry process. Locate errors andmake corrections.
The following three error notices will also appear:

1. Filer’s Signature
2. Filing Date
3. Filer ID

These three errors refer to items that must be completed just prior to filing the report.

IMPORTANT: Once you file a report, this is an irretrievable action, and the information in the filed report
can not be altered in the future. Amending the “Filed Report™ is your only option to correct an error.

Error Messages and Explanations

The following examples of error messages that you may receive during the validation process. The correct
procedure to remedy errors that your filing receives is as follows:

> From the “failed diagnostics” window, chooseOK if you are aware of the existing errors, and you will
be returned to the Instructions W indow so that

you may navigate to the correct form in order to @) Louisiana Electronic Disclosure System | ¥]

make necessary adjustments. g z et
fyad Your filing contains validation errors.

> If you need more information to determine where 9 *To retumn to the main menu and correct these errors,
errors exist within your filing, select the Details click"0K"
button for a listing of all detected errors. Y ou *To view a description of the validation errors,
may print this report, if nec essary, by choosing click "Details".
the print option. : ) ,
*To ignore these errors and continue filing,
> Again, selecting OK will return you to the ek Continte:

Instructions Window so that you m ay make
necessary corrections in order to val idate your

Detas | Continue
filing for upload.

[~ Always show details automatically

These errors can be tracked by referenc  ing the form
information, provided in the diagnostic report.

Error Message Explanation
Embedded double-quotes (“) not allowed Quotation marks within fields are not permitted [example, “Nickname”] and

should be removed before attempting to upload.
Parentheses,[ example, (Nickname)], may be used as a substitute

Leading Blanks {e.g. “TEXT”} not allowed Character spaces before data within fields are not permitted (example Jones )
and should be removed before attempting to upload.

Invalid Amount format: When a field requires a numeric amount, only arabic numerals (1,2,3,4,etc.) will be
accepted.

Non-numeric data in Numeric Field When a field requires a numeric amount, only arabic numerals (1,2,3,4,etc.) will be
accepted.

{Field Number} is Required, but field is empty A required field has been left blank, and needs information in order to pass the

validation process. Refer to the form and file numbers to locate.

Signatory {T}reasurer or {C}andidate ? A form has not been signed, and needs authorized signatory in order to pass the
validation process.

Sup/Opp Code “_ Invalid (Valid Codes: S, O) There is an invalid or non-entry where one is required.
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Error Messages/Explanations cont’d.

Error Message Explanation
Value given {_} is Invalid for this Field An invalid entry has been performed, and should be remedied before attempting to

upload. (Example, substituting letters for numerals in a numeric field)

Conditionally Required field is Empty A field that has become a “required field” based on information for this “filing”
has been left blank, and should have information entered before attempting to
upload.

Individual’s Last Name Not Given Name information missing, and should be entered in full before attempting to
upload.

Street Address is Missing Address information missing, and should be entered in full before attempting to
upload.

__not a valid 2-character USPS State Code State code missing or invalid, and should be entered in full/correctly before

attempting to upload.

zip code is Invalid or Missing / Zip Zip code information is missing, and should be entered in full/correctly before
attempting to upload.

Filing Method

If you selected to continue, having made any necessary corrections, you should now see the Filing Method
Screen. The Filing Method Screen has four methods to select from:

> TCP/IP Selectif you have an active SLIP/PPP (Internet) connection to thserver that receives filings.
> Dialup Select if you would like to dial the server that receives filings directly.

> A: To download filing onto floppy disk in drive A.

> B: To download filing onto floppy disk in drive B.

If this is the first run of LALoad™, Filing Upload, click the Configure button to open the “Communications
Settings” screen.

Filing Configure (Communication Settings)

The Communications Settings screen is divided into four sections:

Filing Information
Upload Methods: Select TCP/IP if you have an active SLIP/PPP (Internet) connection to the server
that receives filings, or select Dial Up if you wouldlike to dial this server directly. Select driveA or

B to download the filing onto floppy disk.

TCP/IP host

Enter the name of the Internet server that receives the filings: www.ethics.state.la.us.
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Diskette
Select drive A or B to download filing onto floppy disk.
Dialup

Dialup filing is no longer available.

Filer Information
E-mail
Enter an e-mail address to which the servercan acknowledge a filing, e.g. YOU @server.com

Fax

Leave the FAX field blank. FAXed acknowledgments are not available.

Agency ID

Enter: LA

Dialup COM port settings
Port number

Enter the number (e.g. 1,2,3,4 etc.) of a COM porto which a modem is connected. External modems
are typically connected to COM 2; internal modems to COM3 or COM 4.

Baud Rate
Enter the modem speed in bps (e.g. 9600, 14400, 19200, 28800, 33600, 57000, etc.)
Data bits, Parity and Stop bits

Select the appropriate values. The default setting are:

Data bits 8
Parity None
Stop bit 1

If you need help to upload using ‘Dialup’, and are not sure about setting up the COM port directly,
please call our Technical Support Staff for help.
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Although values must be entered in every field, the Dialup COM port settings are not used if the
Upload method in the Upload section is TCP/IP.
After a filing method has been selected andyour communication settings have been set up (you need only do this once),
click the OK button. This will bring up the Password/Filing ID screen.
Password/Filing ID

The Password/Filer ID screen has three edit fields:

> Password Enter the password assigned bythe Louisiana Board of Ethics, by which this filing
can be authenticated.

> Filer ID Enter the ID of the entity m aking this filing (e.g. CC123456). This is the same
number assigned by the State Board of Ethics.

> Previous ID If the current filing amends a previous filing, enter the ID of the previous filing.
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